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Network Simulation 

Tools - OPNET

Advanced Topics In 

OPNET

Configuration and Analysis of 

Routing Behavior in IP Networks

Outline of Presentation

 RIP Deployment and Analysis

No_Failure Scenario

Failure Sccenario

OSPF Configuration and Analysis

No_Area

Area

Balanced
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Objectives

Routing protocols deployment and configuration 
in OPNET

Configure and analyze the performance of the 
Routing Information Protocol (RIP) model

Routing behavior analysis in networks configure and 
analyze the performance of the Open Shortest Path 
First (OSPF) routing protocol
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RIP: Routing Information 

Protocol

A Routing Protocol Based on the 
Distance-Vector Algorithm
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Creating a New Project

 Open OPNET Modeler  Choose New from the 

File menu

 Select Project and click OK

 Name the project Routing_RIP

 The scenario NO_Failure  Click OK.

 In the Startup Wizard

 Initial Topology dialog box

 Make sure that Create Empty Scenario is selected  Click 

Next 

 Select Campus from the Network Scale list

 Click Next three times  Click OK
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Creating and Configuring the 

Network

 Go to Object Palette  internet_toolbox

 Add to the project workspace one 
ethernet4_slip8_gtwy router and two 
100BaseT_LAN objects

 Close the Object Palette dialog box

 Save your project
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… Creating and Configuring the 

Network

 Connect the router and the LANs with a 
100BaseT

 RClick on Router1  Edit Attributes

 Expand the IP Routing Parameters hierarchy and 
set the following:

 Routing Table Export = Once at End of Simulation

 Click OK and then save your project
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… Creating and Configuring the 

Network

 Select all the objects 
in the network

 Router, 2 LANs and 
interconnection

 Make three more 
copies and make 
sure that your 
network look like 
this

 Use PPP_DS3 links 
to interconnect the 
routers
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Choosing the Statistics

 RClick anywhere in the project workspace and 
select Choose Individual Statistics from the 
pop-up menu

 In the Choose Results dialog box, check the 
following statistics:

 Global Statistics  RIP  Traffic Sent (bits/sec)

 Global Statistics  RIP  Traffic Received (bits/sec)

 Nodes Statistics  Route Table  Total Number of 

Updates

 Click OK and then save your project
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Configuring the Simulation

 Set the duration to be 10.0 minutes

 Click on the Global Attributes tab and change the 
following attributes:

 IP Dynamic Routing Protocol = RIP

 This sets the RIP protocol to be the routing protocol of all routers in 
the network

 IP Interface Addressing Mode = Auto Addressed/Export

 RIP Sim Efficiency = Disabled

 If this attribute is enabled, RIP will stop after the "RIP Stop Time." 
But we need the RIP to keep updating the routing table in case 
there is any change in the network (as we will see in the second 
scenario)

 Click OK and then save the project
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… Configuring the Simulation
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Link Failure Scenario

 In the network we just created, the routers will 
build their routing tables, and then they will not 
need to update them further because we didn’t 
simulate any node or link failures. In this 
scenario we will simulate failures so that we can 
compare the behavior of the routers in both 
cases
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… Link Failure Scenario

 Duplicate the first scenario from the Scenarios
menu and name it Failure  Click OK.

 Open the Object Palette and select the Utilities
palette from the dropdown menu

 Add a Failure Recovery object to your 
workspace and name it Failure
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… Link Failure Scenario

 RClick on the Failure object  Edit Attributes

 Expand the Link Failure/Recovery Specification
hierarchy  Set rows to 1  Set the attributes of 

the added row, row 0, as shown in the next figure

 This will “fail” the link between Router1 and Router2 
200 seconds into the simulation

 Click OK and then save the project
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… Link Failure Scenario
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Running the Simulation

 To run the simulation for both scenarios 
simultaneously:

 Go to the Scenarios menu  Select Manage 

Scenarios

 Change the values under the Results column to 
<collect> (or <recollect>) for both scenarios

 Click OK to run the two simulations

 After the two simulation runs complete, one for 
each scenario, click Close 

 Make sure to save your project

4/1/2007 Planning and Analysis of Routing Behavior in IP Networks 16



9

Viewing the Results

 Select Compare Results from the Results
menu

 Change the drop-down menu in the right-lower 
part of the Compare Results dialog box to 
Stacked Statistics as shown
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… Viewing the Results

 Select the Total Number of Updates statistic 
for Router1 and click Show

 You should get two graphs, one for each 
scenario. RClick on each graph and select Draw 
Style  Bar

 The resulting graphs should resemble the 
following

 You can zoom in on the graphs by clicking-and-
dragging a box over the region of interest
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… Viewing the Results
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Obtain the IP Addresses of the 

Interface

 Before checking the contents of the routing 
tables, we need to determine the IP address 
information for all interfaces in the current 
network. Recall that these IP addresses are 
assigned automatically during simulation, and 
we set the global attribute IP Interface 
Addressing Mode to export this information to a 
file
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… Obtain the IP Addresses of the 

Interface

 From the File menu choose Model Files 

Refresh Model Directories

 From the File menu choose Open

 From the drop-down menu choose Generic Data 
File  Select the Routing_RIP-NO_Failure-

ip_addresses file

 The other file created from the Failure scenario should 
contain the same information

 Click OK
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… Obtain the IP Addresses of the 

Interface

 The following is a part of the gdf file content. It shows the IP 
addresses assigned to the interfaces of Router1 in our network

 The interface of Router1 that is connected to Net11 has the IP 
address 192.0.0.1 

 Your result may vary due to different nodes placement

 The Subnet Mask associated with that interface indicates that the 
address of the subnetwork, to which the interface is connected, is 
192.0.0.0 

 Logical AND of the interface IP address and the subnet mask
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… Obtain the IP Addresses of the 

Interface
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Comparing the Routing Tables 

Content

 Go to the Results menu  Open Simulation Log

 Expand the hierarchy on the left as shown below  Click on the 

field COMMON ROUTE TABLE

 Carry out the previous step for both scenarios
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Routing table of Router1 

(NO_Failure scenario)
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 The following are partial contents of Router1’s routing 
table for both scenarios 

 Your results may vary due to different nodes placement

Routing table of Router1 (Failure 

scenario)
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OSPF: Open Shortest Path 

First

A Routing Protocol Based on the Link-
State Algorithm
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Creating a New Project

 Start OPNET Modeler  Choose New from the 

File menu

 Select Project and click OK  Name the project 
Routing_OSPF, and the scenario No_Areas 

Click OK

 In the Startup Wizard: Initial Topology dialog 
box

 Make sure that Create Empty Scenario is selected 

 Click Next  Select Campus from the Network 
Scale list  Click Next three times  Click OK.
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Creating and Configuring the 

Network

 Go to Object Palette  routers
 Add to the project workspace eight slip8_gtwy

routers

 Switch the Object Palette to links
 Use PPP_DS3 links to connect the routers

 Save your work and move on
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Configuring the Link Costs

 OPNET router models support a parameter called a 
reference bandwidth to calculate the actual cost

 Cost = (Reference bandwidth) / (Link bandwidth)

 The default value of the reference bandwidth is 1,000,000 Kbps.
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… Configuring the Link Costs

 To assign the costs to the links of our network, 
do the following:

 Select all links in your network that correspond to the 
links with a cost of 5 in the above graph

 Select the Protocols menu  IP  Routing 

Configure Interface Metric Information

 Assign 200,000 to the Bandwidth (Kbps) field 

Check the Interfaces across selected links radio 
button, as shown  Click OK.
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… Configuring the Link Costs

 Repeat these configurations 
for all links with a cost of 10 
but assign 100,000 Kbps to 
the Bandwidth (Kbps) field

 Repeat these configurations 
for all links with a cost of 20 
but assign 50,000 Kbps to the 
Bandwidth (Kbps) field

 Remember to Save your 
project
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Configuring the Traffic Demands

 Select both RouterA and RouterC

 Select the Protocols menu  IP  Demands  Create Traffic 

Demands

 Check the From RouterA radio button as shown  Keep the color as 
blue  Click Create

 Now you should see a blue-dotted line representing the traffic demand 
between RouterA and RouterC
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… Configuring the Traffic Demands

 Create a new traffic demand from RouterB to RouterH

 Now you can see the lines representing the traffic demands as 
shown

 To hide these lines: Select the View menu  Select 
Demand Objects  Select Hide All

 Save your project
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Configuring the Routing Protocol

 Select the Protocols menu  IP 
Routing  Configure Routing 
Protocols

 Check the OSPF check box 
Uncheck the RIP check box 
Uncheck the Visualize Routing 
Domains check box

 Click OK.

 Select RouterA and RouterB only
 Select the Protocols menu  IP 

Routing Select Export Routing 
Table for Selected Routers  Click 
OK on the Status Confirm dialog box
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Addresses Configuration

 Select the Protocols menu  IP 
Addressing  Select Auto-Assign IP 

Addresses

 Save your project and move on
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Simulation Configuration

 Click on   and the Configure Simulation 
window should appear.

 Set the duration to be 10.0 minutes.

 Click OK and then save your project.
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Areas & Load Balancing

 In the network we just created, all routers 
belong to one level of hierarchy (i.e., one area) 

 Also, there is no load balancing enforcement for 
any routes

 Two new scenarios will be created. 

 The first new scenario will define two new areas in 
addition to the backbone area

 The second one will be configured to balance the 
load for the traffic demands between RouterB and 
RouterH
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The Area Scenario

 Select Duplicate Scenario from the 
Scenarios menu and give it the name Areas 

Click OK.

 Area 0.0.0.1

 Select the three links that connect RouterA, RouterB, 
and RouterC

 Select the Protocols menu  OSPF  Configure 

Areas

 Assign the value 0.0.0.1 to the 

Area Identifier  Click OK
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The Area Scenario

 RClick on RouterC  Edit Attributes

 Expand the OSPF Parameters 

 Expand the Loopback Interfaces

 Expand the row0

 Assign 0.0.0.1 to the value of the Area ID attribute

 Click OK

 Area 0.0.0.2

 Select the three links that connect RouterF, RouterG, and 
RouterH

 Select the Protocols menu  OSPF  Configure Areas

 Assign the value 0.0.0.2 to the 

Area Identifier  Click OK
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The Area Scenario

 To visualize the areas we just created, select the 
Protocols menu  OSPF  Visualize Areas  Click OK

 The network should look like the following one with 
different colors assigned to each area

 you may get different colors though

 Note that the area you did not configure is the backbone 
area and its Area Identifier = 0.0.0.0
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The Balanced Scenario

 Under the Scenarios menu, Switch to Scenario 

Select No_Areas.

 Select Duplicate Scenario from the Scenarios menu, 
and give it the name Balanced  Click OK

 In the new scenario, select both RouterB and RouterH

 Select the Protocols menu  IP  Routing 
Configure Load Balancing Options  Make sure 

that the option is Packet-Based and the radio button 
Selected Routers is selected

 Click OK

 Save your project
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Running the Simulation

 To run the simulation for the three scenarios 
simultaneously:
 Go to the Scenarios menu  Select Manage 

Scenarios

 Click on the row of each scenario and click the Collect 
Results button.

 This should change the values under the Results 
column to <collect>

 Click OK to run the three simulations

 After the three simulation runs complete, one for 
each scenario, click Close

 Save your project
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Viewing the Results : No_Area

 Go back to the No_Areas scenario

 To display the route for the traffic demand between RouterA and 
RouterC

 Select the Protocols menu  IP  Demands  Display Routes for 

Configured Demands

 Expand the hierarchies as shown and select RouterARouterC

 Go to the Display column and pick Yes  Click Close
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Viewing the Results : No_Area

 The resulting route will appear on the network
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Viewing the Results : No_Area

 Repeat the previous step to show the route for 
the traffic demand between RouterB and 
RouterH. 
 Depending on the order in which you created the network 

topology, the other “equal-cost” path can be used, that is, the 
RouterB-RouterA-RouterD-RouterF-RouterH path
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Viewing the Results : Areas

 Go to scenario Areas.

 Display the route for the traffic demand 
between RouterA and RouterC
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Viewing the Results : Balanced

 Go to scenario Balanced

 Display the route for the traffic demand 
between RouterB and RouterH


